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Micro Focus Visual COBOL 2.3 Update 1 for
Eclipse Distributed Edition Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product overview

The Micro Focus Visual COBOL for Eclipse Distributed Edition package comprises the following products
which you can download from your Electronic Product Delivery Note:

• Visual COBOL for Eclipse - the product provides an Eclipse-based integrated COBOL development
environment for Windows or Linux. Visual COBOL for Eclipse provides COBOL JVM support and
enhanced compatibility with ACUCOBOL and can be used standalone for developing local applications
or in conjunction with the Visual COBOL Development Hub to develop remote projects in Linux and
UNIX.

• Visual COBOL Development Hub - the product provides a rich desktop development environment based
on the Eclipse IDE with high-performance server-based tools for managing builds, source code access
and the debugger engine. Visual COBOL Development Hub also provides a central administration site,
simplifying the development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Visual COBOL.
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What's New
This release provides enhancements in the following areas:

• Integration with Eclipse
• Application Server JCA support for Enterprise Server
• Code analysis
• Code coverage
• Compiler directives
• Data File Tools
• Editor writing assistance
• File Handling
• Library routines
• Micro Focus Unit Testing Framework
• Managed COBOL syntax
• Native COBOL syntax
• Rosetta Stone for COBOL, .NET and Java Developers
• UNIX and Linux platform support

Integration with Eclipse

Back to Top

This release provides enhancements in the following areas:

Editor:

• COBOL editor:

• You can now specify the increment for the COBOL and the standard line numbering from Window >
Preferences > Micro Focus > COBOL > Editor > Line numbering.

• You can now toggle single or multiple lines between commented and uncommented states.

Building applications:

• Environment variables - a new page, Build Environment, in the project's properties enables you to
specify environment variables for your applications. You can also specify environment variables that only
apply at run time on the run or debug configuration for the application.

Application Server JCA support for Enterprise Server

Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

This release provides support for automatic connection recovery to an active Java application server when
an enterprise server region is restarted. This applies to COBOL resource adapters.

Code analysis

Back to Top

This release provides support for performing code analysis at the command line using Ant which enables
the integration of code analysis in CI frameworks. Features include:

What's New | 5



• Support for performing code analysis at the command line using the project's .cobolBuild Ant script
and specifying a target.

• New Ant targets for code analysis - analyze and build.and.analyze. These enable you to only run
analysis and produce analysis data or to build and produce build artifacts as well as analysis data.

• New Micro Focus Ant task, analysis, for the .cobolBuild file. A parameter for this task enables you
to specify whether the build fails or continues when code analysis results are received.

• New parameters for code analysis for the cobol Ant task - analysisData, analysisDataDir.
• New Ant type, ruleList, for the .cobolBuild file - enables you to specify the rules to execute.
• Support for running analysis using a custom .cobolBuild file from outside of the project directory or

the workspace.

See the Micro Focus Ant User Manual in the Micro Focus Infocenter for more details on the new task, types
and parameters.

Code coverage

Back to Top

The code coverage reports are now integrated with the IDE and with the editor. Features include:

• A new Code Coverage view (Eclipse) showing the statistics of what percentage of the code has
executed.

• Navigation from the Code Coverage view (Eclipse) to the missed and covered blocks in the editor.
• Colorization in the editor of blocks that were executed (covered blocks) or not (missed blocks).

Compiler directives

Back to Top

The following Compiler directives contain new parameters in this release:

• ILMAIN - you now specify the main entry point for the executable program, which can be specified either
as class-name::method-name, or just as method-name. For example, ILMAIN"classA::methodB" or
ILMAIN"methodB". The first format can be used to distinguish between multiple methods with the same
name in different classes.

This directive is now available for JVM COBOL.
• OOCTRL - a new parameter, +/-A, as been added. Set this parameter to -A to allow ActiveX controls in

your COBOL application to use classes and methods in the OLE class library. The default is +A, which
does not allow it.

Data File Tools

Back to Top

This release provides improved security and increased support for more file types. Features include:

• Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.

• When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).

• Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data.

Eclipse editor coding assistance

Back to Top
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This release includes various improvements in the Content Assist support for COBOL in the following
areas:

• Native COBOL - support is now available for OCCURS statements
• Managed COBOL - suggestions are now available in the working storage section and in the following

scenarios:

• Arithmetic expressions in method arguments
• Casting variables and some expressions
• Creating arrays using the TABLE OF expression and indexers
• Generics
• Implements and inherits
• Javadoc comments are now displayed (Eclipse)
• Type name filtering in constructs and attributes
• Managed type headers, method heathers and index headers.
• Nested types
• SIZE OF expressions
• String concatenations
• TYPE OF constructs
• Unqualified members access - using the SELF:: or SUPER:: syntax

• Support for float literals has been enhanced.
• Suggestions are now available for more COBOL verbs such as TRY and RAISE (in managed COBOL)

and EXAMINE, INSPECT, SEARCH, GO TO, INITIALIZE, INVOKE, and UNLOCK (in native COBOL).
• There are new IDE configuration settings for inserting suggestions and for case handling.

Enterprise COBOL 5.2

Back to Top

With the introduction of Enterprise COBOL 5.2, the following features are supported:

• The VOLATILE keyword is supported within the data entry description; although, this is treated as
documentary. It has also become a reserved word when under the ENTCOBOL dialect.

• Format 2 of the SORT statement no longer treats the COLLATING SEQUENCE clause as
documentary-only.

• The SUPPRESS clause of the XML GENERATE statement has been enhanced.
• The IBM z/OS JSON parser API, as documented for the IBM z/OS client web enablement toolkit.

File Handling

Back to Top

The following enhancements have been made to file handling processes:

• A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMAT8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (.idx file) containing the indexed key information.

You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.

• Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

Library routines

Back to Top

The following library routines are new in this release:
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• CBL_CODESET_SET_MAPPING - enables you to change the codeset in effect.
• CBL_RUNTIME_ERROR - forces an application to terminate with a run-time error condition.

Micro Focus Unit Testing Framework

Back to Top

This release provides the following enhancements:

• Updates to the test runner command line options:

• Using the -testcases: option, you can now specify a list of test cases to execute.
• The new -report:markdown option enables you to produce test reports in github style markdown

format (.md).

You can use various Third-Party utilities such as pandoc to convert .md files into HTML or PDF
format.

• Support for running test suites using dynamic metadata - you use an entry point in the test case and,
when it is called during the preparation stage of the test case, you can change various fields exposed
through mfunit.cpy to update the metadata of the test case.

This is an alternative to specifying metadata for a test case in the text fixture file (.mfu).
• Support is now available for creating and debugging test cases written in procedural managed COBOL

(procedural code compiled as managed). The following new test runners are supplied:

• mfurunil, for .NET COBOL code
• mfurunj (Windows) and cobmfurunj (UNIX) for JVM COBOL code.

Managed COBOL syntax

Back to Top

The following enhancements have been made to the managed COBOL syntax:

• A new command line utility, mfjarprogmap, is available to allow you to create the necessary Java
property file when calling COBOL programs that have been compiled as part of a package.

• You can now create generic iterators.
• You can now use the Profiler utility to obtain detailed statistics on the run-time performance of managed

COBOL applications.

Native COBOL Syntax

Back to Top

The following items are new features of the native COBOL syntax:

Class condition tests New and updated class condition tests are available for DBCS, KANJI, and
JAPANESE.

RM/COBOL compatibility

Back to Top

The RM/Panels syntax is now supported in Micro Focus COBOL applications.

Rosetta Stone for COBOL, .NET and Java Developers

Back to Top

The product Help now includes a quick and easy to use syntax guide for developers who need to learn OO
COBOL syntax when modernizing COBOL applications for the Java or .NET platforms. The guide includes
side-by-side equivalent syntax for COBOL, C#, VB and Java.
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UNIX and Linux platform support

Back to Top

This release is now supported on SUSE and Red Hat platforms that are running the little-endian
PowerLinux architecture.

Note: These are 64-bit platforms only.

There are a few restrictions when running in this environment:

• The cob flag -p, which enables profiling, is not supported on Red Hat platforms.
• The cobmode utility is not supported.
• SQL functionality is restricted to OpenESQL support (ODBC and JDBC) only.
• The RM File Manager (RMFM) is not supported.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Data Tools
• Editor Writing Assistance
• IDE
• Run-Time System
• SQL: OpenESQL
• SQL Option for DB2

Data Tools

Back to the list

• When filtering a data file, if there is no valid temporary directory set, you are prompted to set one using
the option in the Preferences dialog box.

• The editor no longer allows you to open a file if the file size (without header size) is not a multiple of the
record size on disk; an error is produced instead.

• The editor no longer allows you to open a file if the file size without header size is not a multiple of the
record size on disk; an error is produced instead.

• The level numbers displayed in a record layout correspond to the levels used in the .idy file that was
used when the structure file was created.

Editor Writing Assistance

Back to the list

• IntelliSense (Visual Studio) or Content Assist (Eclipse) suggestions are no longer offered if you start
typing numbers and automatic triggering of suggestions is enabled.

IDE

Back to the list

• When compiling to multiple executables from the command line, you must specify the -logger parameter
to enable the correct log to be output to the console.

2848855 (1102932)
• For a file added to a JVM COBOL project by adding the folder that stores the file (using the Source tab

on the Micro Focus > JVM Build Path > Source page in the projects' properties), there is now a new
context-menu command, Copy to Output Directory, in COBOL Explorer. Choosing this command on a
file triggers a build of the project and copies the file into the output directory.

2699374 (1094326)

Run-Time System

Back to the list

• The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.
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If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.

To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:

mfaudit.timeout = n

Where n is the timeout value in milliseconds.

To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.

If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

2838689 (1101685)
• Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE

class condition tests:

• IS [NOT] DBCS

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.

• IS [NOT] KANJI

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.

• IS [NOT] JAPANESE

When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.

When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

SQL: OpenESQL

Back to the list

• The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
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dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:

• Run a DSN bind against the customer database. Or:
• Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss

\InstallDigitsFunction.sql script.

This is a one-time only change to the database.

2843818 (1102248)

SQL Option for DB2

Back to the list

• Spurious errors were sometimes returned while querying using an ALIAS.

2830383 (1100609)
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Debugging

• When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.

You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.

• Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:

1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
  <DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>

3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.

4. Start Eclipse from the same command or shell prompt.
• Remote debugging does not work for programs running on AIX or HP machines, if you are trying to

debug using Visual COBOL installed on a Linux machine.

Documentation

• A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with searching and indexing the
help in the Eclipse help viewer if you are running Eclipse on a machine that has this version of JRE
installed.

Database Access

• If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual COBOL or HCO for
DB2 LUW in Enterprise Developer and the DB2 software is not installed on the client machine where
you are using the Eclipse IDE, you receive background parsing errors in your application. To resolve the
issue, you can do either one of the following:

• Disable background parsing Window > Preferences > Micro Focus > COBOL > Editor and
disabling the checkbox for Background parsing.

• Install the IBM DB2 client-side software on the machine on which you are running Eclipse. Go to the
IBM Support Home and locate the page entitled "IBM Download Fix Packs for IBM Data Server
Client Packages" .
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Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

• HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Character Animator
• Code Analysis
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Debugging
• Documentation
• Editor Writing Assistance
• Enterprise Server
• File Handling
• IDE
• Integrated Preprocessor
• Interface Mapping Toolkit
• Micro Focus Common Client
• Micro Focus Directory Server
• Monitoring and Management
• Run-Time System
• SQL: COBSQL
• SQL: DB2
• SQL: OpenESQL
• SQL Option for DB2
• XML Support

Adis

Back to the list

• Deleting a DBCS character no longer causes corruption when the ADISCF options 15 Pre Clear and 29
Read Screen are specified.

2848637 (1102857)

Character Animator

Back to the list

• Breakpoints set on paragraphs or sections can now be unset.

2845763 (1102710)
• Breakpoints are saved correctly when Animator is detached.

2842488 (1102878)
• Failure to detach the Animator from a process no longer results in the breakpoints being lost.

2842488 (1102117)
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Code Analysis

Back to the list

• The GO TO statement in the analysis result now has a valid sequence line.
• Handling for TRY-CATCH-FINALLY code block has been implemented. An issue with Level 78 constant

declared in linkage section has been fixed.

Common Communications Interface

Back to the list

• The performance of Fileshare servers on Linux and UNIX platforms has been substantially improved
since the 2.2 Update 2 and 2.3 releases of Visual COBOL and Enterprise Developer.

2829622 (1101067)
• On UNIX, the product previously was looking for the cciusers.dat file (used for the initial population of

the MFDS Internal Security users and groups) in the /etc/ folder. Starting with this release, the
cciusers.dat file in $COBDIR/etc/ is used in preference. This removes the requirement to store
cciusers.dat in the /etc directory.

• Components that use the SSL/TLS support in CCI, such as Fileshare and MFDASMX, can now use
private key files in binary (DER) format.

Communications Server

Back to the list

• The Enterprise Server EZ Sockets feature no longer fails to initialize at system startup if the MFCS
connection to MFDS is unusually delayed.

2847439 (1102743)

Compiler

Back to the list

• The expression 'instance of type com.microfocus.cobol.program.Reference' (or the .NET equivalent) no
longer produces unverifiable code in either JVM COBOL or .NET COBOL.

2844614 (1102378)
• OSVS report writer programs now compile as expected.

2848192 (1102831)
• SQL programs containing procedural $SET CONSTANT directives now compile as expected.

2847029 (1102768)
• Passing variable length groups to a user defined function now produces correct object code, which

executes as expected.

2845100 (1102408)
• An implicit definition of a VALUE OF FILE-ID, that is, when the program does not declare the data-name

specified in the VALUE OF FILE-ID clause, has been fixed. Previously, the implicit definition was being
made external when it should not have been.

2844151 (1102278)
• COPY statements that span multiple lines no longer stop REPLACE operations from working as

expected.

2843367 (1102672)
• A REPLACE statement that acts upon a literal containing a continuation character, where the literal also

contains quotation marks that start and end on different lines, now compiles as expected.

2841444 (1102573)
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• COPY REPLACING now correctly affects a REPLACE statement, even if a REPLACE statement is
already active.

2841281 (1101930)
• COBOL applications using ActiveX controls need to add the -A option to the OOCTRL Compiler

directive in order to invoke methods in the ActiveX control.

2840671 (1101874)
• In the execution of an XML GENERATE statement, the '&' character is now replaced as expected, even

when the associated field is numeric.

2839493 (1101911)
• Warning message "COBCH0990W No period following EXEC SQL INCLUDE END-EXEC. DB2

coprocessor will fail" is now restricted to mainframe dialects only.

2833943 (1101053)
• Alphanumeric ACCEPT statements that specify the CONVERT phrase, under RM(ANSI), now work as

expected.

2833548 (1100998)
• A DBCS name specified as an EXTERNAL ASSIGN name in a SELECT statement is now processed as

expected.

2833547 (1100996)
• A DISPLAY of a national literal now executes as expected.

2833546 (1100995)
• A DISPLAY of the result of the DISPLAY-OF intrinsic function with a national literal argument now

executes as expected.

2833544 (1100994)
• The HOSTRW directive no longer truncates Report Writer files when there is no RECORD CONTAINS

clause in the FD for the report file.

2826147 (1100638)
• A program compiled with a mainframe dialect that contains a source line with non-ASCII characters in

Area C no longer incorrectly receives the flag message "COBCH1082S Source line is too long".

2809384 (1097885)
• An ALTER statement on a paragraph defined in a previous section, which also had an ALTER statement

on that paragraph name, now executes as expected.

2514516 (1079210)
• The informational message "COBCH1210 COMP processed as DISPLAY (future occurrences not

indicated)" has been fixed so that it is produced based on the COMP directive setting and not the
DIALECT setting.

• A COBRT114 error in generated code on Itanium platforms, for extremely large programs (> 2^24 bytes)
has been fixed.

2844642 (1102395)
• A link error "fatal error LNK1190" when compiling to an executable on 64 bit Windows no longer occurs.

2843600 (1102215)
• A bug in generated code on Intel-x86 32-bit platforms, when generated with opt (4), which caused an

infinite loop, has been fixed. The bug affected SORT on a table that has an "occurs ... depending on ..."
clause.

• A bug during compilation with the OPT(3) directive set, where a loop variable could contain an incorrect
value after a PERFORM UNTIL loop, has been fixed.

• An error no longer occurs as the result of using the 'AS template-1' phrase within an INVOKE
statement. Previously, this could generate a COBRT240 runtime error.
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• On little-endian 64-bit platforms, such as Windows 64-bit or Linux x86 64-bit, a bug could occur with the
following code: add 1 to var-a add 1 to var-a giving var-b where var-a is a comp or comp-x item less
than 8 bytes in size. The result of the bug was that the wrong value was stored in var-b. This bug has
been fixed.

• While debugging using previous versions, an exception occurring in a program using copy files could
lead to the debugger showing an arbitrary position in one of the copy files.

2825779 (1100297)
• A compile time error when compiling to JVM bytecode, and where $CLASSPATH is longer than 4096

characters, has been fixed.

Data Tools

Back to the list

• When filtering records, it is based on the selected encoding when the Filter dialog box was opened.
Previously, the filter was only using ANSI encoding.

• The editing caret no longer disappears when in Edit mode.
• The Hex View is now displayed when you click Toggle Hex after opening a data file that does not

contain a layout.
• Deleting the last record in a sequential fixed-block file or a line sequential file no longer produces an

error message or crashes the editor.

• When copying and pasting records, the record length for fixed block files is no longer resized.

2833640 (1101732)

Debugging

Back to the list

• The handling of NLS, Japanese and multi-byte character sequences has been improved, when
animating programs on UNIX.

2836278 (1101545)
• On Windows, the CBL_DEBUG_START routine will now use the COBANIMSRV environment variable

as the identifier, if the identifier passed in is NULL. This also means that cross-session animation now
works as per the UNIX environment.

Documentation

Back to the list

• Dead Code Analysis is not supported for remote COBOL projects. Clarification of this restriction has
been added to the documentation.

2814273 (1098595)
• When handling XML files, after a successful WRITE action, the size of the XML file written is returned

as the status code.

2587541 (1085484)
• When using Fileshare with the CCISM protocol, ensure the server is started using the /SC switch. This

switch starts Fileshare in synchronous communications mode, which gives better performance than
when using Fileshare with the CCITCP protocol. Without this switch, Fileshare operations may be
slower.

• An Enterprise Server error message has been added to the help pages for CASKC0048, process soft-
killed failed and was hard-killed.

2846350 (1102574)
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• The ldpli topics have been updated to include information about native ld options.

2840325 (1101829)
• The product help now provides the correct definition of the ES_ESM_RESSEC environment variable.

2836105 (1101281)

• The "mfsupport" utility is now correctly named and spelled as MFSupportInfo, for Windows platforms.

2848869 (1102896)
• In the topic "Sample Parameters File", the value of Keys towards the end of the code sample has been

changed from 48 to 60.

2844479 (1102300)
• The parameter TSOE_JOBPREFIX has been replaced with TSOE_JOBCHAR.

2844210 (1102719)
• Additional information added to the help pages for the audit event codes emitted by the External

Security Facility (ESF) and Micro Focus Directory Server (MFDS).

2842807 (1102120)
• If you receive a 9/064 file status, this is informing you that a process has attempted to open a file using

a different locking mode than the one that is already in place. The locking mode is determined by the
tunable strict_file_locking. All processes accessing the same file need to be using the same locking
mode; that is, all have the tunable set to the same value, which can be either 'true' or 'false'.

2837405 (1101440)

• Option D(o) in the Character Animator is only applicable when you are debugging intermediate (.int)
code.

2839572 (1101835)

Editor Writing Assistance

Back to the list

• IntelliSense (in Visual Studio) and Content Assist (Eclipse) no longer offer verbs within EXEC blocks.
The END-EXEC statement is offered instead.

• The IntelliSense suggestions now include the attributes for any reference, output or returning
parameters that are explicitly declared in the linkage section.

• An issue where IntelliSense (Visual Studio) and Content Assist (Eclipse) offered Sort/Merge items
where only file items were valid has been resolved.

(616206)
• Intellisense (Visual Studio) and Content Assist (Eclipse) now only offer suggestions for types which are

suitable to the context. For example, the suggestions for a CATCH phrase only include exception types
and the suggestions after NEW only include constructable types.

• Intellisense (Visual Studio) and Content Assist (Eclipse) now offer members of the current type when
there is no qualification using "SELF::" or "SUPER::".

• Intellisense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for READY TRACE and
RESET TRACE.

• The Intellisense (Visual Studio) and Content Assist (Eclipse) suggestions no longer include multiple
imported types with the same short names.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for specifying array
types (OCCURS) in managed COBOL.

• IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer all relevant data for EXHIBIT
statements.

• IntelliSense (in Visual Studio) and Content Assist (in Eclipse) now correctly handle the automatic import
of the namespace (and any nested types) from the current type.
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• Condition-value items are now correctly accepted as complete conditional expressions.
• IntelliSense (Visual Studio) and Content Assist (Eclipse) no longer offer completion suggestions outside

of their proper scope.
• IntelliSense proposals now correctly replace unquoted copybook names in the editor.

Enterprise Server

Back to the list

• The caslock utility now validates the APPLID. In order for caslock to remove all locks for a given cluster
client, the passed APPLID must already be known to the GLM - for example, it must already have an
entry in the CASGLM.LCK file.

2847684 (1103145)
• When processing a WSBIND that contain nested occurs levels, the group level is now correctly

maintained.

2844738 (1102697)
• XA transactions will now end when an ECI request fails with PGMIDERR.

2843668 (1102276)
• The order in which user privileges are checked when accessing cataloged files has changed. First, a

check for the alter privilege is performed. If access is denied, Enterprise Server performs a check for
update privileges. If this check fails as well, a final check for read access is performed. This is reflected
in both the console log output and in any Audit Manager events that are generated.

2842162 (1102048)
• Previously, when generating a MQRFH2 header, the CCSID that was used was 0. This resulted in an

abend APIJ on the CPIL transaction and in an error 2111 on the MQGET API. The MQRFH2 header is
now generated with the correct CCSID values.

2841974 (1102004)
• When the targetService option was enabled for the JMS Invoke Webservice, no response was returned

to the application if the URIMAP was not found. This caused the transaction to hang. A message is now
sent to the Dead Letter Queue, and the application fails with an error message DFHPI0112.

2841602 (1101959)
• casspool type 16 records (spool-printed-88) are now being processed and the printed spool records get

deleted when using Delete from the ESMAC page.

2839657 (1101706)
• A Run-Time System error 114 no longer occurs when a GET request is received.

2825851 (1100157)
• You can now start Enterprise Server instances that have the casuesm exit enabled. If you are already

using this exit, you must recompile your applications using the updated cascbesm.cpy that is in the
cpylib subfolder in the product installation directory. You also need to include the version check at
initialization time that is implemented in the skeleton casuesm.cbl file that is in the src in the product
installation directory.

2821228 (1099658)
• You no longer receive a memory leak in cassi processes when using the Micro Focus External Call

Interface.

• If no license has been found when starting Enterprise Server, Enterprise Server Administration now
periodically checks whether a license server is present.

2836688 (1101388)

• The Enterprise Server External Security Facility, using LDAP-based security, no longer incorrectly
matches a wildcard character ("*") in a resource access rule to a period (".") in the requested resource
name. The double wildcard sequence ("**") does match a period (".").

20 | Resolved Issues



2854402 (1103604)
• When using LDAP-based security immediately after installing Enterprise Server, with the sample access

rules provided with the product, the TRANCLASS definitions in ESMAC are now granted administrative
access to as it is for other resource types.

2838380 (1101547)
• The LISTREFERENCES command now works correctly when the resource class names use special

characters.

File Handling

Back to the list

• OPEN EXTEND EXCLUSIVE for sequential files accessed via ACUFH/RMFM now correctly locks the
file.

2849233 (1102953)
• If a program opens an RM/COBOL or ACUCOBOL-GT data file, and the file format has been specified

at compile time (and not in a run-time config file), then file assignments containing a sub-path will
correctly search locations specified by COBDATA.

2842825 (1102218)
• Rebuild now correctly processes the key structure defined through an options file.

2837028 (1101412)
• Relative filenames specified with dot-slash (e.g. ./file.dat) will now match filename tags in the extfh.cfg

configuration file (e.g. [file.dat]).

2832386 (1100932)

• Rebuild option /t now supports extended ESDS (XESDS) files. Rebuild also allows you to create an
ESDS file without supplying the index key information (option /k).

2837756 (615857)
• Rebuild now allows the case where "9" is specified after ":"

2836782 (1101437)

IDE

Back to the list

• Debugging of remote application attachments now respects the order of source containers during
source lookup instead of relying on the information in the IDY files.

2845910 (1102501)
• Error annotations that follow INCLUDE statements are now displayed on correct lines.

2845634 (1102720)
• The 'delimited' and 'delimited by size' COBOL program clauses no longer prevents the Outline view and

Content Assist from functioning correctly.

2843597 (1102236)
• Each project now has its own build console that accumulates build output until explicitly cleared or

closed by the user.

2841821 (1102009)
• Added new system property build.errors.limit which limits the maximum number of problem error

markers created as part of a build. You can modify this property by editing the eclipse.ini file.

2840702 (1101870)
• A momentary loss of network connectivity can result in COBOL Project settings being lost if the project

was stored on a network location.
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2833101 (1101082)
• When debugging native COBOL applications the .idy file loaded by the debugger is now used to create

the editor's Outline view and other information such as content assist and colourization.

2827035 (1101229)
• A full rebuild of all projects in a workspace could sometimes be triggered after restarting Eclipse.

2816310 (1101363)
• Debugging network file system remote projects can be made faster by using the 'Remote File System

Directory' container to specify the source lookup path on the Source tab of the Debug launch
configuration.

2792882 (1096491)
• By selecting the "Create top-level folder" option when importing the copybooks and then adding the

folder to the Dependency Paths/Copybooks, the project will compile successfully.

2682665 (1092789)
• It is now possible to change the compiler directives in the project settings without cleaning the build

artifacts through the use of a new preference.

2647695 (1089794)

Integrated Preprocessor

Back to the list

• Programs with EXEC SQL INCLUDE statements that have a trailing period that is not immediately
following the END-EXEC now compile as expected with the COBSQL preprocessor.

2844222 (1102486)
• A user preprocessor which calls directly the 'CP' system preprocessor now behaves as expected during

the syntax checking of source files you are editing.

Interface Mapping Toolkit

Back to the list

• Ebiz execution no longer fails when tracing is enabled and several programs contain a mismatched
linkage offset.

• JSON request messages containing multi-byte UTF8 characters caused errors for REST web services.

Micro Focus Common Client

Back to the list

• COBOL Web, EJB, and REST services with Japanese characters in their names can now be deployed
to Enterprise Server.

Micro Focus Directory Server

Back to the list

• Fixed an issue in the Enterprise Developer Administration HTML GUI if a long user id value was input.

2846804 (1102971)
• Enterprise Server instance startup performance has been improved, particularly when the Enterprise

Server Administration GUI has been configured to use SSL.

2837359 (1101501)
• Issue fixed where the Enterprise Server Administration HTML GUI occasionally became unresponsive if

configured to use an SSL browser connection.

2834446 (1101342)
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• The Enterprise Server user id no longer needs to have security administration access permissions to
start an Enterprise Server instance if external security is specified.

Monitoring and Management

Back to the list

• The Operations Manager agent no longer logs a warning event 21405 for machines being monitored
that do not have Enterprise Server installed .

2830110 (1100895)

Run-Time System

Back to the list

• In the JVM COBOL run time, an alphanumeric comparison with a collating sequence now gives correct
results for character values greater than 127.

2839717 (1101845)

• If a file is opened for Read with 'deny neither read nor write' and then the same file is opened for Read
(or Read/Write) with 'deny write', then when the second FD is closed, the 'deny write' file lock was NOT
removed. This has now been resolved.

2837230 (1101419)
• 64-bit Windows only, and native generated code only. Programs containing code of the form 01 f

comp-2. compute f = f ** 0.5 no longer give a load error at run time (for .gnt code) or fail to link (.obj
code) with the message "unresolved external symbol _tMc4506".

2836893 (1101465)
• When using "mfauditadm -r" on an audit file containing processes that have very long command lines,

the process could terminate early with a memory fault. This has now been resolved.

2832770 (1101000)
• The Sharedmem demo has been updated to make it compatible across all supported UNIX platforms.

Previously, on some platforms the semaphore synchronization did not work.
• Repeatedly calling and cancelling different programs in different threads could cause the application to

hang. This has now been resolved.

SQL: COBSQL

Back to the list

• The COBSQL preprocessor has been updated to correctly handle P(CP) with the NOSQL directive.

2850394 (1103086)
• Background parse should now create temporary files with names that differ from the actual build

process.

2843719 (1102613)

DB2

Back to the list

• A compiler error that resulted from the DB2 ECM preprocessor incorrectly handling embedded
comments within an SQL statement has been fixed.

2846756 (1102646)
• An HCO pre-compiler routine incorrectly replaced an underscore in host variable name which resulted

in invalid host variable. This has now been fixed.

2837674 (1101487)
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SQL: OpenESQL

Back to the list

• An overflow problem with host variables of type System.Decimal has been fixed.

2849939 (1103195)
• OpenESQL has been updated to correctly handle cursors in static methods when using DBMAN=ODBC

in a managed application.

2847268 (1102968)
• A problem with EXEC ADO REBIND CONNECTION has been fixed.

2846426 (1102645)
• In some scenarios, OpenESQL for ADO.NET incorrectly handled level 49 VARCHAR host variables

defined with zero (0) length.

2845409 (1102510)
• HCOSS with SQL(CHECKCALLPARAMS) now correctly determines parameter types and directions for

SQL, SQL synonym, and SQL CLR stored procedure calls that use four-part names, and that are
located on other servers or in other databases.

2844292 (1102483)
• HCOSS did not fully support DB2 ROW_NUMBER().

2843937 (1102362)
• Using SQL(CHECK) with .NET applications caused an error on Oracle.

2842102 (1102037)
• The OpenESQL JVM Runtime was updated to correctly process a FETCH from a VARCHAR column

where the field is zero length.

2841149 (1102637)
• The Project Properties user interface has been updated to include SYBASE and INFORMIX-NEW on

the COBSQLTYPE options list.

2840953 (1101877)
• An EXEC ADO GET DATATABLE statement for DataTables contained within a dataset resulted in SQL

errors.

2837717 (1101484)
• HCO for SQL Server incorrectly returned result set locators for result sets containing VARCHAR(MAX)

columns.

2832384 (1101169)
• The ADO and JDBC runtimes have been updated to fix a share lock problem that occurred when

SQL(ISOLATION) was set.

2797208 (1096456)

• To correct a problem when using SQL(DETECTDATE) with SQL Server datetime columns, applications
updating to Visual COBOL 2.3 might require use of the SQL(DETECTDATE) directive if they use SQL
Server datetime columns with PIC X host variables. Alternative solutions are to switch to datetime2, or
to use SQL TYPE TIMESTAMP host variables.

2850022 (1103058)
• To correct a problem with closing CURSORs, SQL(SPCALLLOCAL) can now be used to instruct

OpenESQL to detect and close cursors associated with simulated stored procedures not closed by an
application.

2848402 (1102838)
• When using SQL Server version 2012 SP2 or later, OpenESQL now supports a [NOCHECK] statement

prefix to enable SQL(CHECK) to be disabled on a per-statement basis. If used with other statement
prefixes, it must come first. When compiling programs that use global temporary tables, HCOSS
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executes converted DECLARE GLOBAL TEMPORARY statements at compile time. These enable
subsequent statements that reference the temporary table to be checked using SQL(CHECK).

2847791 (1102782)
• OpenESQL now supports SQL(DETECTDATE=SERVER) when using the ADO.NET runtime and SQL

Server version 2012 or later. SQL(DETECTDATE=SERVER) is ignored when using ADO.NET with
earlier versions of SQL Server, and when using any other database.

2846825 (1102701)
• When migrating a DB2 application using HCOSS, a compiler error caused by string concatenations that

included literals containing angle bracket characters has been corrected.

2846226 (1102582)
• A new directive, CHECKSP, has been added to the OpenESQL preprocessor to verify whether or not

parameters match the COBOL definitions defined in a stored procedure. If not, the OpenESQL
preprocessor generates error ES0127. The syntax is: SQL(CHECKSP=<spd-filename> CHECKSP
applies only when SQL(SPCALLLOCAL) is also used.

2844399 (1102329)
• The POSTGRESQL parameter for the TARGETDB SQL compiler directive option was erroneously

omitted from the drop-down list in the user interface.

2842879 (1102128)
• When using the OpenESQL JDBC Managed Runtime with positioned updates on a cursor, an error

occurred when the same cursor was opened and closed multiple times.

2841857 (1102003)
• The OpenESQL runtime for ADO.NET was erroneously trimming trailing spaces from variable-length

input host variables that used an explicit-length field.

2841721 (1102106)
• A problem with disconnecting named connections when using the JDBC runtime for OpenESQL has

been fixed.

2841508 (616495)
• When compiling applications with SQL(DIALECT=MAINFRAME), literals could be corrupted with

embedded spaces.

2839826 (1101752)
• In European locales, Oracle queries failed to return the decimal symbol for floating point results

returned to decimal numeric host variables.

2839066 (1102162)
• OpenESQL SAVEPOINT handling was not working as expected with Static SQL.

2838227 (1101571)
• An HCOSS stored procedure called from multiple locations in either the calling application or in a

nested stored procedure, and that returns result set locators, resulted in an SQLCODE error.

2834386 (1101104)
• HCO for SQL Server returned incorrect output parameter values when a CALL statement specified a

stored procedure name in a host variable.

2833755 (1101022)
• OpenESQL with DATE+EUR erroneously returned values representing a 12-hour clock. Returned

values now correctly represent a 24-hour clock.

2833683 (1101017)
• The SPD Generator did not set the NOTRUNC directive when generating a SQL CLR wrapper.

2829499 (1102075)
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• When running in ODBC mode, the OpenESQL Assistant DCLGEN sometimes generated incorrect
TIMESTAMP and DATE column sizes. It now generates the TIMESTAMP(6) columns as PIC X(26) and
the DATE columns either as PIC X(19) or X(10) based on the NLS_DATE_FORMAT setting.

2823577 (1099922)
• The documentation has been updated to clarify the issue of trailing spaces in comparisons for PIC X

host variables with CHAR and VARCHAR columns.

2806980 (1097582)
• An attempt to compile in Visual COBOL with OpenESQL using unsupported HCOSS directives now

returns errors rather than warnings. HCOSS is not supported in Visual COBOL.
• OpenESQL for ADO.NET did not recognize and handle Oracle's full managed .NET provider in addition

to the original partially managed provider. Note: The two providers are not 100% compatible. The
partially managed provider uses NLS settings for date/time formatting and the fully managed provider
uses the local machine locale.

SQL Option for DB2

Back to the list

• The XDB pre-processor incorrectly processed SQL statement that had embedded singles within a
literal. This resulted in receiving an incorrect message "cobsql0111e - no from clause specified error".

2850293 (1103073)

• When using an open cursor with constants comparison in an IN () clause, an Sqlcode -1352 error
occurred.

2844111 (1102266)
• An SQL statement with SELECT caused an XDB with Server Violation error when converting from the

CHARACTER to INTEGER type in the INSERT SQL statement.

2839382 (1101677)
• Incorrect results sometimes occurred when using a host variable for the second parameter of the SQL

scalar function ROUND() function.

2831359 (1101083)

• Exiting SQLWizard processing no longer causes an exception.

2849696 (1103097)
• A problem with the display of code page conversions in the SQLWizard Import/Export dialog boxes has

been resolved.

2846196 (1102659)
• An issue that resulted in a syntax error when editing tables with decimal data has been resolved.

2840937 (1101960)
• Exporting a table with a reserved word as a column name no longer produces an error X020 if the

quoting types are Apost or Quote.

2806803 (1097559)

• An RTS 114 error would sometimes occur on an UPDATE WHERE CURRENT OF CURSOR.

2840936 (1101868)
• When executing a batch job containing XDB Null loads, an error occurred during DSNUTILB processing

when loading the XICU40N DLL.

2840147 (1101785)
• An execution error resulted when using dynamic SQL with an SQLDA SQLN integer much larger than

required for input parameter markers.

2818992 (1099256)

26 | Resolved Issues



XML Support

Back to the list

• PREXML now terminates and returns an error message if there is a problem expanding a copybook.

2472213 (1076394)
• XMLPARSE did not honor the encoding in the XML declaration for output text.

2851343 (1103239)
• XML WRITE with CHECK VALIDITY OUTPUT no longer causes RTS 114 error if the written document

contains an XML declaration.

2837110 (1101424)
• XMLPARSE did not handle CONTENT-CHARACTERS correctly in XMLSS mode.

2822339 (1099692)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2266906 (1066314)
• 2541594 (1081441)
• 2610077 (1087571)
• 2613606 (1088533)
• 2691674 (1093498)
• 2784725 (1095083)
• 2792882 (1102055)
• 2801626 (1097006)
• 2801847 (1097374)
• 2805056 (1097357)
• 2806566 (1097816)
• 2807649 (1097763)
• 2809132 (1097892)
• 2812331 (1098359)
• 2815582 (1099634)
• 2817630 (1101066)
• 2824712 (1100086)
• 2824925 (1099961)
• 2825098 (1100032)
• 2825249 (1101374)
• 2827707 (1100302)
• 2828305 (1100419)
• 2828897 (1100491)
• 2829677 (1100588)
• 2830741 (1100655)
• 2830871 (1100785)
• 2831477 (1100831)
• 2831788 (1100810)
• 2831959 (1100864)
• 2832490 (1100907)
• 2832904 (1100916)
• 2833083 (1101060)
• 2833100 (1101123)

• 2833473 (1101007)
• 2833925 (1101045)
• 2834217 (1101124)
• 2834245 (1101085)
• 2834253 (1101099)
• 2834843 (1101156)
• 2834959 (1101167)
• 2835289 (1101498)
• 2835416 (1101496)
• 2835506 (1101288)
• 2835508 (1101292)
• 2835599 (1101293)
• 2835608 (1101494)
• 2835687 (1101497)
• 2835835 (1101262)
• 2836694 (1101356)
• 2837531 (1101490)
• 2837784 (1101511)
• 2838086 (1101525)
• 2838343 (1101586)
• 2838426 (1101552)
• 2838593 (1101986)
• 2838671 (1101587)
• 2838689 (1102052)
• 2839730 (1101776)
• 2840155 (1101821)
• 2840349 (1101906)
• 2840530 (1101860)
• 2840658 (1101893)
• 2840766 (1101857)
• 2840977 (1102019)
• 2841607 (1101961)
• 2841785 (1101988)

• 2841933 (1102021)
• 2842318 (1102129)
• 2842702 (1102121)
• 2842940 (1102122)
• 2843048 (1102186)
• 2843076 (1102135)
• 2843140 (1102509)
• 2843301 (1102185)
• 2843324 (1102296)
• 2843438 (1102240)
• 2843446 (1102173)
• 2843446 (1102174)
• 2843884 (1102492)
• 2845184 (1102627)
• 2845218 (1102490)
• 2845635 (1102601)
• 2845781 (1102730)
• 2846150 (1102557)
• 2846669 (1102644)
• 2846797 (1102780)
• 2846971 (1103070)
• 2847253 (1102806)
• 2847876 (1102765)
• 2848324 (1103143)
• 2849271 (1103044)
• 2849307 (1102974)
• 2849430 (1103011)
• 2849508 (1102970)
• 2849972 (1103094)
• 2851114 (1103175)
• 2851169 (1103174)
• 2852143 (1103362)
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Installation

Installing Visual COBOL for Eclipse

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows

System Requirements for Visual COBOL for Eclipse (Windows)

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL Sentinel RMS License Manager

3.7GB 75MB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• Visual COBOL enables you to produce both 64-bit and 32-bit applications on 64-bit operating
systems.

• The Enterprise Server feature is not supported on Windows XP.

Software requirements

Note: This product includes OpenSSL version 1.0.1p.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
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Eclipse requirements

• The setup file installs Visual COBOL and Eclipse 4.4.2.

See Installing Visual COBOL into other instances of Eclipse for instructions on how to install Visual
COBOL into other instances of Eclipse installed on your machine.

• Visual COBOL does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to create
both 32-bit and 64-bit applications.

• Visual COBOL requires a 32-bit Java installation.

Software requirements

• Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from 
Oracle's web site and install it anywhere on your machine.

Note: If Java 7 is installed on your machine, to skip installing Java 8, run the Setup file with the
skipjre=1 command line option.

• The setup file also installs .NET Framework v4.5.2 and the Microsoft Visual C++ 2010 and 2012
Redistributables.

See the Java Support Considerations for the Eclipse IDE in the Known Issues and Restrictions section in
your product help for considerations that apply to using the Eclipse IDE and Java.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.

Click here to see this information in the Micro Focus Infocenter.

Click here to see this information in the Micro Focus Infocenter for Micro Focus Visual COBOL
Development Hub.

Product Co-Existence

Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

30 | Installation

http://www.microfocus.com/docs/links.asp?nx=java
http://supportline.microfocus.com
http://documentation.microfocus.com/help/topic/com.microfocus.eclipse.infocenter.visualcobol.eclipsewin/GUID-3280F74E-1512-414A-8E56-0F6CBB2F72F8.html
http://documentation.microfocus.com/help/topic/com.microfocus.eclipse.infocenter.visualcobol.eclipseux/GUID-C571DFD1-5F18-4DC1-934E-0787B01B09FA.html


• Visual COBOL and Enterprise Developer cannot coexist on the same machine.
• You need to be logged in with a user-ID that has write access to the registry structure under

HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  Visual COBOL command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

On UNIX

System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:
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Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(GB)

Sentinel RMS

license
server

(MB)

x86-64
running Red
Hat Linux

Micro Focus installer 923 3.69 1.84 46

x86-64
running SUSE
SLES

Micro Focus installer 927 3.71 1.85 46

Operating Systems Supported

Note: You can produce both 64-bit and 32-bit applications on 64-bit operating systems.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Eclipse requirements

• Visual COBOL only supports the 32-bit Eclipse IDE and requires a 32-bit Java installation.
• Visual COBOL does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to create

both 32-bit and 64-bit applications.
• The setup file installs Visual COBOL and Eclipse 4.4.2. After the installation, you can install the Visual

COBOL plug-in into other instances of Eclipse available on the same machine. The supported versions
are 4.2 and 4.3 for the 32-bit Eclipse only. See Installing Visual COBOL into other instances of Eclipse
for instructions.

Other software requirements

Before installing this product, you must have the following software installed on your computer:

• The unzip utility is required by the setup file.

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• The following libraries must be installed:

Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

glibc-locale-32bit X X

gcc X X

gtk2 (libgtk2, gtk2-
tools-32-bit)

X

libXcomposite1-32
bit

X
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Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

libgdk_pixbuf-2_0-
0-32bit

X

gdk-pixbuf-query-
loaders-32bit

X

libjasper1-32bit X

gtk2-x11
(libgthread-2_0-0-
32bit)

X

libXtst6-32bit X

gcc*.i686 X X

glibc-*.x86_64 X X

glibc-*.i686 X X

libgcc-*.x86_64 X X

libgcc-*.i686 X X

libstdc++-*.x86_64 X X

libstdc++-*.i686 X X

gtk2-*.x86_64 X X

gtk2-*.i686 X X

gtk2-
engines.*.i686

X

gtk2-
engines.*.s390

X

gtk2-
engines.*.x86_64

X X

libXtst-*.x86_64 X X

libXtst-*.i686 X X

libcanberra-gtk2-
*.x86_64

X X

libcanberra-gtk2-
*.i686

X X

libgnome.x86_64 X X

libgnome.i686 X X

PackageKit-gtk-
module-*.x86_64

X X

PackageKit-gtk-
module-*.i686

X

PackageKit-gtk-
module-*.s390

X
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Library Platform

SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

PackageKit-gtk3-
module-*.i686

X

PackageKit-gtk3-
module-*.s390

X

webkitgtk.x86_64 X

webkitgtk.i686 X

webkitgtk3.x86_64 X

webkitgtk3.i686 X

xterm (any
version)

X X

gdb* X X X X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The setup file installs Java
8 u51 32-bit. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.

Note: On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse.
When you start the installation, if the 64-bit version of Java is already installed on your Linux
machine, you might not be able to install Visual COBOL. This is a known issue with the Oracle
Java installers for Linux which prevent you from installing both the 32-bit and the 64-bit versions of
Java on the same machine. To work around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For

example, untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to

install and run Visual COBOL.

Before you start the installation, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
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Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX

To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.

Click here to see this information on the Micro Focus Infocenter.

UNIX and Linux Installer Issues

Installing on Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse. When you start
the installation, if the 64-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevent
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For example,

untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and

run Visual COBOL.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks.
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On Windows

Installing on Windows

Note:

• This version of the product is a full install.
• If you have an earlier version of Visual COBOL installed on your machine, check Installing as an

Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:

1. Run the vce_231.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.4.2, with the Micro Focus plugins already installed,
in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, if you have Java 7 installed on your machine and you want to skip installing Java 8, run the
setup file from the command line with the skipjre=1 command line option.

On UNIX

Installing the software

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing Visual COBOL on UNIX and Linux and a standard RPM (RPM Package
Manager) installer for installing Visual COBOL on Linux. See your product Help for instructions on
how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_2.3_update1_platform

2. Run the setup file with superuser permissions:

./setup_visualcobol_deveclipse_2.3_update1_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_2.3_update1_platform -installlocation="full 
path of new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"
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You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

. /setup_visualcobol_deveclipse_2.3_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

Setting up the environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product

To start Eclipse:

• If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh

• If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:

eclipse

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
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• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter

• Installing into other instances of Eclipse - available in the product Help and in the Micro Focus
Infocenter

• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus
Infocenter

See this information in the Micro Focus Infocenter - for Visual COBOL for Eclipse for Windows click here
and for Visual COBOL for Eclipse for UNIX click here.

Click here to see this information on the Micro Focus Infocenter for Micro Focus Visual COBOL
Development Hub.

On Windows

Installing as an Upgrade

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Visual COBOL Installation Options
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.

To see what parameters you can use, execute the following from the command line:

install-file /help

where install-file for the following products is as follows:

Visual COBOL vce_231.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the InstallFolder parameter.

• Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\LogFilename

Installing silently

Use the /q parameter to install silently:

start /wait install-file.exe /q [parameters]

Examples

• To silently install Visual COBOL into a directory other than the default:

start /wait vce_231.exe /q InstallFolder=c:\DirectoryName
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• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait vce_231.exe /q InstallFolder2=c:\EclipseInstallDirectory

• To skip installing JRE when installing Visual COBOL:

start /wait vce_231.exe /q skipjre=1

On UNIX

Installing as an upgrade

This release works concurrently with the previous version of Visual COBOL, so you do not need to uninstall
it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOL/
eclipse, by default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL/eclipse /opt/microfocus/VisualCOBOL/
eclipseversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Visual COBOL installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL/eclipse"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_2.3_update1_platform -installlocation="full 
path of new location"
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Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.f

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows

Configuring Visual COBOL

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
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2. Make sure you are in the perspective you need to reset by clicking Window > Open Perspective >
Other.

3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Installing X Windows on Windows

Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in your
Visual COBOL installation. By default this will be in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing on Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Visual COBOL and Micro
Focus License Administration. Uninstalling only Visual COBOL does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

On UNIX

Installation | 41



Configuring Visual COBOL

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Open Perspective >

Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Configuring the Environment for Developing RDBMS Applications on UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Repairing

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLEclipse2.3.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

42 | Installation



1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Visual COBOL Development Hub

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

UNIX and Linux Installer Issues

Installing on Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse. When you start
the installation, if the 64-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevent
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For example,

untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and

run Visual COBOL.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

System Requirements for Micro Focus Visual COBOL Development
Hub

Hardware Requirements

The disk space requirements are approximately:
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Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

POWER
running AIX

Micro Focus

installer

419 1.68 GB 838 36.5

HP IA Micro Focus

installer

763 3.05 GB 1526 69

System Z
running Red
Hat Linux

Micro Focus

installer

346 1.38 GB 692 36

x86-64
running Red
Hat Linux

Micro Focus

installer

359 1.44 GB 718 46

SPARC
running
Solaris

Micro Focus

installer

405 1.62 GB 810 40

x86-64
running
Solaris

Micro Focus

installer

375 1.60 GB 750 31

System Z
running SUSE
SLES

Micro Focus

installer

349 1.40 GB 698 36

x86-64
running SUSE
SLES

Micro Focus

installer

364 1.46 GB 728 46

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Note: This product includes OpenSSL version 1.0.1p.

Before installing this product, you must have the following software installed on your computer:

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• The following operating system libraries must be installed:

Library Platform

SUSE 11 Red Hat 6.x Red Hat 7

glibc-locale-32bit X

gcc (gcc-32-bit) X
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Library Platform

SUSE 11 Red Hat 6.x Red Hat 7

gcc*.i686 X X

glibc-*.x86_64 X X

glibc-*.i686 X X

libgcc-*.x86_64 X X

libgcc-*.i686 X X

libstdc++-*.x86_64 X X

gcc*.s390 X X

glibc-*.s390 X X

glibc-*.s390x X X

glibc-devel-*.x86_64 X X

glibc-devel-*.i686 X X

glibc-devel-*.s390 X X

glibc-devel-*.s390x X X

libstdc++-*.i686 X X

gdb* X X X

• Visit the Red Hat Web site for more information.

• Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from 
Oracle's web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute COBOL JVM code, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
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microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements for Micro Focus Visual COBOL Development Hub

To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.

Click here to see this information on the Micro Focus Infocenter.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks.

Installing Micro Focus Visual COBOL Development Hub
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_2.3_update1_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_2.3_update1_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_visualcobol_devhub_2.3_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:
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During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter
• Installing into other instances of Eclipse - available in the product Help and in the Micro Focus

Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

See this information in the Micro Focus Infocenter - for Visual COBOL for Eclipse for Windows click here
and for Visual COBOL for Eclipse for UNIX click here.

Click here to see this information on the Micro Focus Infocenter for Micro Focus Visual COBOL
Development Hub.

Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Visual COBOL Development
Hub, so you do not need to uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable (/opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Micro Focus Visual COBOL Development Hub installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"
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Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Visual COBOL Development Hub Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_devhub_2.3_update1_platform -installlocation="full path 
of new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA
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For example, execute:

[as root] setup_filename –silent -IacceptEULA

After Installing
• The information about Micro Focus Visual COBOL Development Hub is part of the Visual COBOL for

Eclipse product help.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

Setting up the product
1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Visual COBOL Development Hub
running on the UNIX machine and handling all requests from the IDE for building and debugging programs.
Visual COBOL Development Hub provides a UNIX daemon, the Remote Development Option (RDO)
daemon, which initiates the RDO as Eclipse clients connect to it. Whichever environment is used to start
the RDO daemon will be inherited for all servers and hence all build and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated on the Development Hub from one of the Eclipse clients, the
environment used will be inherited from whatever was used to start the daemon. A typical example of the
kind of environment that might need to be set up would include database locations and settings for SQL
access at build/run time.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.
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The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command with superuser authority:

$COBDIR/remotedev/stoprdodaemon <port>

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLDevelopmentHub2.3.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid license either for a 30-day trial or full license of Visual COBOL in order to continue using the
product.

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• Personal Edition licensing is only available with Visual COBOL for Eclipse
• The latest version of the SafeNet licensing software is required. See the Software Requirements

section in this document for more details.
• Your entitlement for using this product is governed by the Micro Focus End User License

Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
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3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Finish to install the license.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Windows

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
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3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

UNIX

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2016. All rights reserved.
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